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CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING 

WEGO OVERVIEW 
The WEGO family of sensors (Figure 1) consists of two product lines:  WEGO III and the WEGO IV.  The 

fundamental difference between the WEGO III and WEGO IV is that the WEGO III products are sealed units.  That makes 
the WEGO III a perfect match for recreational vehicles, Off-Road-Vehicles and Motorcycles.  The WEGO IV line of 
sensors are not weather sealed but they are generally smaller in size.  The reduced size of the WEGO IV makes them 
perfect for Automotive and dyno use.  

The WEGO systems are versatile tuning aids and diagnostic tools.  They can be used on all carbureted and fuel 
injected engines and support most fuels. Measurement range is 10.3:1 to 19.5 Fuel/Air Ratio (.70-1.33 Lambda).  Please 
see Table 1 (below) for a complete comparison of capabilities. 

All Daytona Sensor WEGO units are compatible with gasoline, gasoline/ethanol mix (E10, E15, E85, etc.), ethanol, 
methanol and leaded race fuels.  Select WEGO units display AFR for one or more channels.  Most WEGOs can log over 3 
hours of data including sensor 1 and sensor 2 AFR values, engine RPM, and a spare 0-5V analog input for logging other 
external sensors such as throttle position or manifold pressure.  Please see Table 1 (below) for a matrix of WEGO 
capabilities by part number. 

Many WEGO systems offer built-in data logging.  This built-in data logging capability provides the tuner with a 
means to record Air/Fuel-Ratio or Lambda, RPM and analog inputs such as TPS and boost with an optional Map sensor.  
When the built-in data logger is combined with our free Daytona Sensor Log software this allows the tuner to view mixture 
live while simultaneously recording various engine parameters on a dyno or on the road under real world conditions. Data 
logging is configured and accessed with WEGO Log software and is compatible with Windows. See Table 1 for software 
descriptions and device capabilities. 

All WEGO systems include 0-5 volt analog outputs.  The analog output voltage represents the fuel/air mixture and 
they are compatible with most data acquisition systems used on racecars and engine/chassis dynos.  There is one output 
analog channel for each wideband channel supported by your particular WEGO.  WEGO analog outputs are also 
compatible with EFI tuning devices such as SCT, EFI Live, Diablo, HP Tuners and others. 

The WEGO III Dual Display also has the capability to interface with a customer supplied flex fuel sensor and it can 
display the ethanol content (0-100%).  A switch located below the sensor 2 LED allows selection of normal AFR display or 
percent ethanol display. 

All WEGO Systems with LED Displays have ultra-bright daylight readable blue LED’s.  

All Daytona Sensors WEGO systems utilize low-cost Bosch LSU 4.2 5-wire wide-band oxygen sensors.  By utilizing 
surface mount electronics technology, digital signal processing techniques and a switching power supply for the sensor 
heater, the Daytona Sensors WEGO systems provide the same level of accuracy as lab systems costing thousands of 
dollars. 

Figure 1 – Examples of WEGO Models 

  WEGO III        WEGO III Dual Display 
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     WEGO IIIS          WEGO IIID 

 

       WEGO IV Dual Channel          WEGO IV Single Channel 

For more information about wide-band oxygen sensors including the Bosch LSU 4.2, we suggest that you visit the Tech 
FAQ on our website at www.daytona-sensors.com.  
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WEGO POWER REQUIREMENTS 
The WEGO can operate from 9.0 to 18.0 volts. WEGO systems are intended for nominal 12 volt automotive 

applications. Please refer to Figure 2 for a wiring diagram.  Nominal 12 volt automotive electrical systems on alternator 
equipped vehicles typically operate at 13.8-14.4 volts while the engine is running. Vehicles with nominal 12 volt total loss 
electrical systems (no alternator) can momentarily drop below the 9.0 volt minimum level when heavy loads, such as fans 
or nitrous solenoids engage. This will cause the WEGO to reset and result in a loss of data for 10-15 seconds. 

WEGO units also feature low power consumption (about 2 amps). For small engine applications, you can power the 
WEGO for over one hour from a 12 volt gel cell type rechargeable battery, such as the type used for backup power in 
alarm systems. 

Vehicles with nominal 16 volt electrical systems equipped with race type alternators may reach 18.6 volts while the 
engine is running. The WEGO will shut off if the voltage exceeds 18.0 volts. Call our tech support before attempting to 
install any WEGO system on a nominal 16 volt electrical system with an alternator.  

WEGO3            

111002 2 0 YES NO Analog Out Only NO NO 42 2 Fig. 3c, Page 10  

111003 2x4 8 YES NO Analog Out Only NO NO 42 2x4 Fig. 3e, Page 11 4x 2 Channel products. 
Every V8 Exhaust Port 

111004 2 2 YES NO Analog Out Only NO NO 42 2 Fig. 3c Page 10  

111005 2 2 YES NO Analog Out Only NO NO 42 2 Fig. 3c, Page 10 SuperFlow Dyno w/Pwr Sup 

111006 1 1 YES NO Analog Out Only NO NO 42 1 Fig. 3a, Page 9  

111009 2 2 YES NO Analog Out Only NO NO 42 2 Fig. 3a, Page 9 Connect to Land & Sea 
Dyno w/Pwr Sup 

112001 1 1 YES YES AFR/ANALOG YES NO 42 1 Fig. 3b, Page 9  

112002 1 1 YES YES AFR/ANALOG YES NO 96 1 Fig. 3b, Page 9  

112004 1 1 YES YES LAMDA YES NO 96 1 Fig. 3b, Page 9  

112005 2 2 YES YES AFR/ANALOG YES YES 96 2 Fig. 3d, Page 10  

112006 2 2 YES YES LAM/ANALOG YES YES 96 2 Fig. 3d, Page 10  

WEGO4            

113001 2 2 NO YES AFR/ANALOG YES NO 96 2 Fig. 3g, Page 12  

113003 2 2 NO YES LAM/ANALOG YES NO 96 2 Fig. 3g, Page 12  

114001 1 1 NO YES AFR/ANALOG YES NO 96 1 Fig. 3f, Page 11  

114003 1 1 NO YES LAM/ANALOG YES NO 96 1 Fig. 3f, Page 11  

Table 1. WEGO Capability and Features Matrix 
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WEGO INSTALLATION   

Please refer to Figures 3a–3f on Pages 8-11 for your appropriate wiring diagram. 

Step 1.  Wideband Sensor location and Boss Installation 
Select a convenient mounting location for the Bosch wideband sensors. In general, the sensors should be 

mounted as close to the exhaust valves or exhaust manifold as practical. When choosing a mounting location, 
allow several inches clearance for the sensor wire harness. If your vehicle already has factory O2 sensors, install 
the sensor boss near the factory sensor.  Be sure to install the sensor so it is located between the 9 o’clock and 3 
o’clock position in the pipe.  An O2 sensor installed between 9 – 3 o’clock will avoid excess moisture that can 
gather in the bottom of the exhaust pipe. Excessive moisture can damage the O2 sensor. The wire harness 
should exit straight out from the sensor. Do not loop the harness back onto the sensor body. The sensor responds 
to oxygen pressure. Excessive backpressure will cause a reading error. For turbocharged applications, it is 
recommended to mount the sensor downstream of the turbo. Alternatively, improper oil feeding of the 
turbocharger could cause oil to be discharged out of the turbo into the exhaust thus affecting the downstream O2 
fuel/air mixture readings.  Many tuners run a dual sensor system and mount an O2 sensor before and after the 
turbo so they can compare readings and have the best information available or they install two bosses and move 
the sensor before and after to compare the readings. 

For temporary use during dyno tuning, you can mount the Bosch wide-band sensors in place of the original 
equipment rear oxygen sensors (typically after the catalytic converter). You can also use a sniffer in the tail-pipe, 
however a sniffer setup is not typically the most reliable. For permanent mounting, 18 x 1.5 mm weld nuts must be 
welded onto the exhaust pipe. After welding, run an 18 x 1.5 mm tap through the threads. Failure to clean the 
threads may result in sensor damage. Note that most automotive muffler shops are familiar with oxygen sensor 
weld nut installation on custom pipes. Do not install the sensors until after the free air calibration procedure 
described in the following section. Always use a small amount of anti-seize lubricant such as Permatex 133A on 
the sensor threads.  

Step 2.  Mount the WEGO Unit 

Mount the WEGO Unit.  If applicable, install the WEGO unit where the display will be visible during testing. 
The unit is fully sealed, but should be mounted away from sources of engine or exhaust heat. The unit can be 
secured with #10 screws through the mounting flanges, velcro tape strips or by using nylon tie wraps. 

Step 3.  Connect the Sensor/Sensors 
Connect the Bosch wideband sensors to the 6 pin mating connectors on the WEGO III wire harness. 

Please refer to Figure 3 (WEGO III) and 3a (WEGO IV). 12-foot extension cables (P/N 115004) are available. Be 
sure to route the cables so that they cannot be damaged, tangled or burnt.  Secure the cables properly. 

Step 4.  Connect Primary 12 VDC Power 
Connect the red (WEGO III) or +12 V POWER (WEGO IV) WEGO wire to switched +12V power. Please 

refer to Figure 3 (WEGO III) and 3a (WEGO IV).  You can usually find switched +12V power at an accessory fuse 
on the fuse block. Please avoid using voltage sources that are powering other sensors. This source may not be 

CAUTION: WEGO III units are water-proof. However, the units should not be left 
exposed where they are subjected to rain or high pressure washing.  

IMPORTANT: Ensure the ignition switch is off and battery ground disconnected 
before proceeding. 

IMPORTANT:  Exposing a hot sensor to water or condensation can cause damage to 
the sensor.  Extended time operating without being mounted in an exhaust system 
can also cause damage to the sensor. 
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able to supply the current required to properly operate the WEGO and it may have a negative effect on sensor 
operation. 

Step 5.  Connect the Ground Wire 
Refer to Figure 3 (WEGOIII) and 3a (WEGOIV). Connect the black (WEGO III) or POWER GROUND 

(WEGO IV) WEGO wires to a good frame ground location using the supplied ring terminal.  If you are using a data 
acquisition system, connect the ground wires to the same point that the data acquisition system is grounded. 
Keep the ground connections as short as possible. Try to use an existing wire harness ground location. 

Step 6.  Install and Configure Tach Input (WEGO Model Dependent) 
The tachometer input is optional. Using the tachometer input is highly recommended when using the built-

in data-logging feature. When data logging this input makes it simple to cross reference Fuel/Air to RPM in the 
data log file. The WEGO Data Logging software is used to set the correct scaling for engine RPM in terms of 
pulses per revolution. The unit can easily be set up for operation with 1 to 12 cylinder engines. Refer to the 
software instructions for details. Refer to Figure 3 (WEGO III) and 3a (WEGO IV) on how to connect the RPM 
Input.  

NOTE: If a Volt-Ohm-Meter (VOM) is used to monitor the RPM input (brown wire or tach input) you should 
see about 10.5 volts. This voltage is pulled down to 0 volts when the ignition system is triggered. 

1) Tach signal (preferred for best noise immunity). The unit is compatible with industry standard 12 volt 
square wave tach signals such as what would be used to drive an Autometer or similar aftermarket tach. Most 
aftermarket CD (capacitive discharge) ignitions including the Daytona Sensors CD1, MSD-6 and Crane HI-6 
series have a tach output that you can connect to the WEGO. 1999-2003 Harley-Davidson motorcycles with 
carbureted Twin Cam 88 engines have a tach output on pin 12 of the black ignition module connector. Most 
2001 and later Harley-Davidson motorcycles with 36 pin Delphi fuel injection ECM have a tach output on pin 
3 of the ECM connector.  

2) Coil Negative (-) terminal. The unit is compatible with the signal on the Coil Negative (-) terminal of most 
inductive discharge type ignitions. This includes most OE (original equipment) automotive ignitions and all 
Harley-Davidson® ignitions. WARNING: If using an aftermarket high energy ignition box use the 
tachometer signal source output supplied by the ignition box.  Do not attach the Brown wire or Tach 
Input to the coil output of the aftermarket ignition box.  For automotive distributorless or Harley-
Davidson® single fire systems with multiple coils or coil packs, you can use any one of the Coil negative 
signals. 

3) Motorcycle and small engine CD (capacitive discharge) ignitions. Many Japanese motorcycles and small 
engines use CD ignitions. Any engines with flywheel triggered systems fall into this category. These 
applications will require   a special tach adapter P/N 115005.  

If you have a Japanese motorcycle, download the WEGO Tach Adapter instructions from our website at 
www.daytona-sensors.com. Tips are provided for identifying the type of ignition system in use.   

Step 7.  Monitor Analog Inputs (Optional based on WEGO P/N) 
Optional signal hookups, including engine RPM, analog signal data logging, and flex fuel sensor are 

explained in paragraph titled FLEX FUEL SENSOR. If you are not using these features, tape up the unused 
wires. Please refer to Figure 3 (WEGO III) and 3a (WEGO IV). 

WARNING: Connecting the WEGO III brown wire or WEGO IV TACH INPUT to a high 
voltage (in excess of 12 volts) will damage the unit and void the warranty.  If using an 
aftermarket high-energy ignition system use the tachometer signal source supplied 
with the box.  Do not attach the Brown wire (WEGO III) or Tach Input (WEGO IV) to the 
output of the aftermarket ignition box, the WEGO will be damaged and the warranty 
will be void. 
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For analog input signal data logging, connect the green WEGO III wire to one of the following: 

1) Throttle position sensor. Most engine controls use a TPS (throttle position sensor) with a 0-5 volt signal 
range. Refer to your service manual for details. 

2) Manifold pressure sensor. Most engine controls use a MAP (manifold pressure sensor) with 0-5 volt signal 
range. Refer to your service manual for details. 

3) Other 0-5V analog signals. The WEGO can log any 0-5 volt signal. For other sensors, use a Volt-Ohm-
Meter (VOM) to ensure the signal output is within the 0-5 volt range before connecting it to the WEGO. 

4) Flex fuel sensor (If applicable). Refer to the flex fuel sensor information in paragraph titled FLEX FUEL 
SENSOR for compatible part numbers and required connector modification. Connect the red and black wires 
to switched +12V power and ground. The flex fuel sensor has a digital 50-150Hz square wave output, so 
power and ground connections are less critical. 

Step 8.  Analog Output (Optional for WEGOs with Display) 
You can connect the white and blue wires from (WEGO III) or AFR Output (WEGO IV) to 0-5V analog inputs on 

a data acquisition system.  For more details on Analog Output please refer to paragraph titled ANALOG OUTPUT 

Step 9.  Reconnect the Battery and Verify Operation. 
If data logging is to be used, please refer to the Software Operations paragraph of this manual.  Perform Free-

Air Calibration. 

FREE-AIR CALIBRATION 
After installation, the WEGO system requires free air calibration. This should be done with the sensor dangling in 

free air. The environment must be free of hydrocarbon vapors. We suggest that you perform the free air calibration 
outdoors.   

WEGO WITH Display: 

Step 1. 
Turn the free air calibration trim pot on the WEGO III full counterclockwise. Turn on power and wait for a MINIMUM of 60 
seconds so the system can stabilize. It is recommended that the sensor be allowed to warm up 2 full minutes  

Step 2. 
Slowly turn the free air calibration trim pot clockwise until the display indicates “FA”. Try to set the trim pot at the point 
where the display just starts to indicate “FA”.  Free air calibration is accomplished. 

WEGO WITHOUT Display:  
The WEGO III without displays have red status LEDs for each channel. When power is turned on, the LEDs blink at a 
slow rate until the corresponding sensor has reached normal operating temperature. 

Step 1. 
Turn the free air calibration trim pots on the WEGO III full counterclockwise.  

Step 2. 
Turn on power and wait for a MINIMUM of 60 seconds after the “CL” indication has cleared so the system can stabilize. It 
is recommended that the sensor be allowed to warm up 2 full minutes  

Step 3. 

WARNING: Connecting the green wire (WEGO III) or Analog Input (WEGO IV) to a 
high voltage (in excess of 12 volts) will damage the unit and void the warranty. 
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Then slowly turn each free air calibration trim pot clockwise until the corresponding LED starts flashing at a rapid rate. Try 
to set each trim pot at the point where its LED just starts to flash.  Free air calibration is accomplished. 

Free-Air Calibration Interval:  The free air calibration procedure should be performed at reasonable intervals 
(every 250-500 hours if using unleaded gas or every 2-5 hours if using leaded racing gas) or whenever a sensor is 
replaced. If you cannot get an LED to flash when its trim pot is turned full clockwise, you either have a damaged sensor or 
very high hydrocarbon levels in your environment. Diagnostics: The WEGO III includes internal diagnostics for abnormal 
battery voltage (less than 11 volts or greater than 16.5 volts), sensor open circuit, and sensor short circuit conditions. A 
fault condition causes the status LEDs to blink at the slow rate. A WEGO system with display normally shows AFR or 
status data, (Refer to Table 2) but when a failure is detected an error code will be displayed (refer to Table 3) and 
Troubleshooting at the end of this document.  

WIRING DIAGRAMS 

Figure 3a - Typical Wiring, WEGO IIIS 

 

Figure 3b – Typical Wiring. WEGO III
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Figure 3c – Typical Wiring. WEGO IIID 

 

Figure 3d – Typical Vehicle Hookup for WEGO III Dual Display 
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Figure 3e – Typical Vehicle Hookup for Multiple WEGO IIID Systems 

 

Figure 3f – Typical Vehicle Wiring WEGO IV Single Display 
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Figure 3g – Typical Vehicle Hookup for WEGO IV Dual Display 

 

DISPLAY AND ERROR CODES (WEGOS WITH DISPLAY) 

Table 2 - Normal Operating Display Indications. 

 Display  Definition Possible Cause 

“CL” Cold Warming up, Low Voltage 

10.3-19.5 
gasoline AFR  

AFR value Normal Operation 

“FA” Free Air Indication Normal Operation 

“PC” PC communications Connected to PC 

Table 3 – Diagnostic Error Codes: 

Display Definition Possible Cause 

“SO” Sensor open circuit Sensor Fault, Wiring Fault 

“SS” Sensor short circuit Sensor Fault, Wiring Fault 

“Lb” 
Low battery voltage, Less 
than 11.0v DC 

Battery Low, Incompatible 12 volt source. 

“Hb” 
High battery voltage, 
Greater than 16.5v DC 

Alternator, Regulator Fault, Incompatible 12 volt 
source. 

“OT” Over-temperature warning 
Sensor location in exhaust too close to combustion 
chamber, High Vehicle Exhaust Gas Temperature. 
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Table 4 – Flex Fuel Diagnostic Error Codes: 

Display Definition Possible Cause 

“SF” Flex Fuel Sensor error Sensor Fault, Wiring Fault 

“CF” Contaminated Fuel Fuel Contaminated 

LOGGING DATA (Optional for WEGO systems Equipped with Data Logging) 
The WEGO will start logging data once the sensor has reached normal operating temperature and the unit 

displays an AFR value or “FA”. The unit will not log data when “CL” or “PC” is displayed. The unit stops logging data 
while a diagnostic code is set (however the code is logged). The interval between samples can be set from 0.1-1.0 
seconds using the WEGO Dual Channel Data Logging software. The unit stores the last 12,000 samples. The 

software also displays any logged diagnostic codes. Refer to the software instructions for details.  

The “OT” diagnostic code indicates that the WEGO III unit (not the sensor) is too hot. This may occur if the unit 
is operated for an extended period of time at ambient temperatures above 150° F.   

Data logging for wide-band oxygen sensor 2 is not interrupted when percent ethanol display mode is selected. 
In percent ethanol display mode, additional diagnostic codes include “SF” (sensor fault) and “CF” (contaminated fuel). 

  

NOTE:  When leaving the “PC” mode the WEGO unit may not properly reset to normal 
operation.  If this occurs simply cycle the power to the WEGO and normal operation will be 
restored. 
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EXHAUST CONSIDERATIONS  

The WEGO systems may give inaccurate results under certain situations: 
Excessive exhaust back pressure. Wide-band sensors are affected by back pressure. Excessive back pressure causes 
exaggerated AFR indications under rich and lean conditions, but has little effect at the stoichiometric AFR.  WEGO 
systems are intended to be used with a free-flowing performance exhaust. Overly restrictive stock mufflers may cause 
excessive back pressure under wide open throttle. When used with a turbo system, the sensor must be mounted 
downstream of the turbo. We recommend a sensor before and after the turbo to verify AFR. 

Exhaust reversion. Reversion is the term for a negative pressure wave that can suck ambient air back into the exhaust 
and cause an erroneous lean AFR indication. Exhausts without mufflers, such as open headers or “drag pipes” on 
motorcycles, usually suffer from reversion effects and may not be suitable for use with a WEGO system. Reversion effects 
will also occur with certain exhausts used on “bagger” style motorcycles, where two pipes split off near the rear cylinder. 
Reversion effects will be most noticeable at idle, part throttle low RPM cruise, and deceleration.  

Excessive scavenging. Turbo systems or tuned exhausts in combination with a high overlap camshaft profile can force 
unburned air and fuel mixture through the cylinder into the exhaust and cause an erroneous rich AFR indication. 

Misfiring. If the AFR is so rich that the engine misfires, high levels of oxygen will remain in the exhaust gas and result in 
an erroneous lean indication. 

ANALOG OUTPUT 
WEGO units are useful in a wide range of engine tuning and testing applications. WEGO units can be programmed 

with the WEGO Dual Channel Data Logging software to display Lambda or correct AFR values for any hydrocarbon fuel 
with a known stoichiometric ratio. After free air calibration, accuracy is ±0.007 Lambda ( 0.1 gasoline AFR) over the 
range of 0.70-1.33 Lambda (10.3-19.5 gasoline AFR). Regardless of the units displayed on the WEGO, data is logged 
internally in Lambda units and can be rescaled in the software for any fuel type. Refer to the software instructions for 
details.  

All WEGO units have the same scaling for the   0-5 volt analog outputs on the white and blue wires: 

Lambda:  Lambda = .1361 x (Vout + 5)       Vout = (7.345 x Lambda) - 5 

Gasoline:  AFR = 2 x (Vout + 5)                   Vout = (0.5 x AFR) - 5 

Additional scale factors are listed on our Tech FAQ at www.daytona-sensors.com. 

When power is first turned on and the sensors are not yet at their normal operating temperature, the analog outputs 
are held at less than 0.20V. During free air calibration and while the unit displays “FA”, the analog outputs will be near 
5.0V. 

GASOLINE TUNING GUIDELINES 
Higher AFR values correspond to a leaner (less fuel) condition. The practical operating range for most engines 

using gasoline fuel is from approximately 11.5 to 14.7 AFR. Combustion of a stoichiometric mixture (exactly enough air to 
burn all the fuel) results in 14.7 AFR indication. Automotive engines with catalytic converters operate near 14.7 AFR 
during cruise and idle. Race engines usually require a richer mixture to limit cylinder head temperature and prevent 
detonation.  Table 5 (Motorcycle) and Table 5a (Automobile) lists reasonable AFR values for race engines without 
emission controls.  

  

NOTE:  To gain a better understanding of tuning various fuels please read “Tuning Various 
Fuels.  What is Lambda? Why should I care?” located at the end of these instructions.  
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Table 5 – Recommended AFR Tuning for Motorcycles (Gasoline, 14.64 Stoich) 

Operating Mode Recommended AFR 

Cold Start (first 30 sec) 11.5-12.5 AFR,  0.78-0.85 Lambda 

Idle 12.8-13.5 AFR,  0.87-0.92 Lambda 

Part Throttle Cruise 13.0-14.0 AFR,  0.88-0.95 Lambda 

Wide Open Throttle (normally aspirated) 

12.5-12.8 AFR,  0.85-0.87 Lambda 

Values down to 11.5 AFR or 0.78 Lambda may be used 
to reduce detonation  

Wide Open Throttle (turbo/supercharged) 10.6-11.8 AFR,  0.73-0.80 Lambda 

Table 5a – Recommended AFR Tuning for Automobile (Gasoline, 14.64 Stoich) 

Operating Mode Recommended AFR 

Cold Start (first 30 sec) 12.0-12.5 AFR,  0.82-0.85 Lambda 

Idle 14.0-15.0 AFR,  0.96-1.025 Lambda 

Part Throttle Cruise 14.0-15.0 AFR,  0.96-1.025 Lambda 

Wide Open Throttle (normally aspirated) 

12.5-12.8 AFR,  0.85-0.87 Lambda 

Values down to 11.5 AFR or 0.78 Lambda may be used 
to reduce detonation  

Wide Open Throttle (turbo/supercharged) 11.0-12.0 AFR,  0.76-0.82 Lambda 

EXHAUST SNIFFERS 
WEGO units can be used with easily fabricated exhaust sniffers that allow temporary installation on most 

automobiles and motorcycles for tuning and diagnostic purposes, including vehicles with catalytic converters. The exhaust 
sniffers are constructed from materials that are readily available at any hardware store. For more details, download the 
Automotive Exhaust Sniffer Tech Note and Motorcycle Exhaust Sniffer Tech Note from our website at www.daytona-
sensors.com. 

FLEX FUEL SENSOR (WEGO III) 
The WEGO III is compatible with Continental flex fuel sensors P/N 1312202158 (short fuel lines) or P/N 

1218601076 (long fuel lines). These sensors correspond to GM P/Ns 13577379 or 13577394.  

With the Flex Fuel Sensor option, a WEGO III can display the percentage of ethanol/methanol in the fuel.   

A minor modification is required to cut off two keying tabs at sides of the connector (white arrows in Figure 4 
below). For proper wiring see Figure 3. 
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Figure 4.  Flex Fuel Sensor Modification at Arrows 

REPLACEMENT OXYGEN SENSORS AND REPLACEMENT 
The Daytona Sensors WEGOs use standard Bosch LSU 4.2 sensors used on a VW production application (Bosch 

P/N 0 258 007 057/058 or VW P/N 021 906 262B). The proprietary VW connector is replaced with a smaller Deutsch DT-
04-6P. We offer replacement sensors with the Deutsch connector installed.  

If you are testing multiple engines, we also offer additional 18 x 1.5 mm weld nuts for sensor mounting and 18 x 
1.5mm hex socket plugs that screw into the weld nuts and allow removing sensors after tuning. 

Some engines using CD (capacitive discharge) ignitions may require a special tach adapter for engine RPM data 
logging. Please call our tech support at 386-322-7390 for details. 

TROUBLESHOOTING FLOWCHART 
Follow the troubleshooting flowchart shown below. Experience has shown that most units returned for warranty are 

OK and typically have another problem, such as a degraded sensor, or bad power connection. 

 
  

CAUTION: Racing gasoline containing lead will quickly degrade the sensors. Under these 
conditions, expected sensor life is less than 10 hours. There is no warranty on sensors. 



 

Daytona Sensors LLC, 240 Springview Commerce Drive - BLD 1 Suite J Debary, FL 32713                 WEGO 
(386) 322-7390   www.daytona-sensors.com                1/2020 

Page 17 
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Troubleshooting Flowchart (WEGO without LED Display) 
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SOFTWARE OVERVIEW 
WEGO Data Logging software (hereafter referred to as WEGO software) runs under Microsoft Windows 

XP/Vista/7/8/10. This software allows users to view real-time data and download and display data logged by the WEGO III 
and WEGO 4 single channel units.  There are two versions of this software, Single Channel and Dual Channel Data 
Logging.  Other than the difference in the number of channels supported, the software is operationally identical and both 
are supported by these instructions. 

WEGO UNITS THAT SUPPORT DATALOGGING 

Datalogging is supported by the following WEGO models: 

WEGO III Part Numbers:  WEGO IV Part Numbers: 
112001     113001 
112002     113003 
112004     114001 
112005     114003 
112006      
 

It is important to know data logging is accomplished by the WEGO hardware, not this software.  This software 
provides the ability to configure, access, display and reset the data logging features in the WEGO hardware.  When the 
WEGO is powered on data logging starts immediately after sensors have warmed up with no user input required.  Logged 
data is non-volatile, meaning it will not be lost if WEGO power is lost.  For more many details about how data logging 
works please refer to paragraph USING DATA LOGGING.  

After WEGO Log software is launched, the main screen appears blank. Data logged by the WEGO unit must be 
downloaded before it can be displayed, by using the Download Data from WEGO command on the Communications 
menu. Once data has been downloaded, it is automatically displayed on a chart recorder type screen. You can save this 
data by using the Save File command from the File menu. You can also display a previously saved data file by first using 
the Open File command on the File menu.  

A sample data file (Sample.log) is included in the program folder. 

WEGO single channel units connect to your PC by means of a USB interface. A USB cable is supplied with the 
unit. The PC must have a free USB port. If you have an older PC without USB capability, you cannot use the unit.  

When launched for the first time, the program uses COM1 as the default port. In most cases, you will have 
configured the unit’s USB interface to use a different COM port, such as COM5. Use the Port Setup command on the 
Communications menu to select the correct COM port. The program will remember the new port setup.  

WEGO Data Logging software version 9.0 adds real-time display and enhanced support for multiple fuels and 
analog input scaling. 

PC REQUIREMENTS 

We recommend a laptop with Pentium processor and super VGA display (SVGA with 1024 x 768 pixel resolution) 
running Windows XP/Vista/7/8. Data chart display is graphics intensive and a high-speed Pentium processor is 
recommended. Processors slower than 300 MHz will exhibit sluggish program loading and response. The PC must have a 
CDROM drive for program loading.  

WEGO software includes print commands to print downloaded data. The program has been tested with Hewlett-
Packard laser and inkjet printers and Epson inkjet printers. We recommend using a color inkjet printer. 

The WEGO unit connects to your PC by means of a USB interface. A USB cable is supplied with the unit. The PC 
must have a free USB port. If you have an older PC without USB capability, you cannot use the unit. The WEGO unit must 
be powered by the vehicle during PC communications. 

USB INSTALLATION 

WEGO III and WEGO IV units require installation of USB interface drivers. If you have already installed the USB 
interface drivers, you can skip this step. 

The WEGO III and WEGO IV USB interface is based on the FTDI FT232R chip and drivers that allow the unit to 
emulate a standard Windows RS-232 COM port. Updated Windows drivers, installation instructions and troubleshooting 
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tips are available on the FTDI website at www.ftdichip.com. Additional information and troubleshooting tips can be found 
on the PC Link Tech FAQ on our website at www.daytona-sensors.com.  

A new USB driver that simplifies the installation process is available. This installs as an executable file, similar to 
other Windows programs. The Windows Found New Hardware Wizard will then detect the USB device when it is first 
connected and automatically install the correct driver without the user having to browse out to the CDROM. 

Before proceeding with installation, shutdown any other applications that may be running. For Windows Vista, you 
must disable the User Account Control (UAC) during installation. If you are not familiar with the UAC, please refer to the 
Vista UAC Tech Note on our website's PC Link Tech FAQ for details. 

1. Make sure your WEGO is not connected to your PC.  

2. Insert the Daytona Sensors CDROM. When the Daytona Sensors autorun menu appears, click on Software. Scroll 
down and click on the USB Driver link. When the File Download dialog box appears, click on "Run this program from 
its current location." Ignore any security warnings and click on Yes to continue.  

3. After installation of the driver is complete, turn on power to the WEGO unit and connect it to the PC with the supplied 
USB cable. The Windows Found New Hardware Wizard will appear and complete installation of the USB drivers. 

COM PORT CONFIGURATION 

After completing the installation steps outlined above, you must configure the new COM port using Device 
Manager.  

1. Windows XP: click Start, Settings, Control Panel, System, Hardware, and then Device Manager. Windows Vista: 
click Start, Control Panel, System and Maintenance, and then Device Manager. Windows 7/8/10: Click Start, Control 
Panel, System and Security, and then Device Manager. For more information, visit www.pcsupport.about.com. 

2. Scroll down to Ports (COM and LPT). The new WEGO will appear as a USB Serial Port. Click on this new port. Click 
on the Port Settings tab. 

3. Click on Advanced. In many cases the wizard will have installed your new unit as COM4 or COM5. For optimum 
performance, you should change the BM Options Latency Timer to 2 msec as shown in Figure 1. 

Figure 1 – COM Port Configuration 

 

 
Once you have configured a COM port number for your new unit, make sure that you use this same COM port selection in 
the WEGO Log software by using the Port Setup command from the Communications menu. 

SOFTWARE INSTALLATION 

The software is supplied on CDROM media or in the form of a compressed file downloaded from our website. The 
installation process uses InstallShield. This industry standard installer is based the new Microsoft Windows Installer 
service that greatly reduces potential problems such as version conflicts and allows for application self-repair.  

Before proceeding with installation, shutdown any other applications that may be running. For Windows Vista, you 
must disable the User Account Control (UAC) during installation. If you are not familiar with the UAC, please refer to the 
Vista UAC Tech Note on our website's Tech FAQ for details. 
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Use the Windows Explorer or the Run command from the Windows Start Menu to launch setup.exe in the WEGO 
Log folder on the CDROM or the setup.exe file downloaded from our website. InstallShield will install the software in an 
appropriate folder under Program Files. 

Once InstallShield has completed the installation, WEGO Log will appear on the Windows Start Menu. You can 
then launch it just as you would any other Windows program.  

WEGO Log requires the Monospace 821 BT fixed pitch printer font in order to properly align columns when printing. 
The Monospace 821 BT font is included in the distribution media and automatically copied to your Windows Fonts folder 
during installation. A backup copy is also placed in the program folder. If you accidentally delete this font, use the Install 
New Font command from the Fonts folder File menu. The filename associated with Monospace 821 BT is monos.ttf. 

CONNECTING TO THE WEGO 

The WEGO unit connects to your PC by means of a USB interface. A USB cable is supplied with the unit. Turn on 
power to the WEGO unit. We recommend that you do not run the engine while you are downloading data. 

WEGO SETUP 

The WEGO program has auto-connect capability and a COM port scan function to aid in initial setup of the 
communications link. You can use the Port Setup command from the Communications menu to display the dialog box 
shown below and select the correct COM port.  

If you are not sure what COM port the WEGO has been assigned to, you can click on the Scan button to 
automatically detect and select the correct port. Before you do so, make sure that the WEGO is connected to your PC and 
powered up. Once the correct COM port has been selected, the program will remember this setting. 

If you enable the Auto Connect check box, the program will try to connect to the WEGO every time the program is 
started. Please note that you must have the correct COM port selected and the WEGO connected and powered up in 
order for auto-connect to work properly. 

Figure 2 – Data Port Setup 

 

CONFIGURE DATA LOGGING 

Prior to using the WEGO, you must set up the data logging parameters. Use the Edit WEGO Parameters command 
from the Edit menu. A dialog box will appear as shown in Figure 3. You can set the data logging interval and RPM pulses 
per revolution and additional parameters for newer WEGO units. 

The WEGO data buffer stores the last 8000 data points. If you set the data logging interval to 0.50 seconds, the 
unit will log over one hour of data. Data logging intervals of 0.2-1.0 seconds are suitable for on-road tests; a shorter 
interval of 0.10 seconds is recommended for dyno tuning. You can clear the data within the WEGO by using the Clear 
WEGO Data Buffer command from the Communications menu. If you change the data logging interval, you should also 
clear the WEGO data buffer. 

(8000 Samples / Desired Samples per second) / 60 = Minutes of Logging Available 

Example: (8000 / 10) / 60 = 13.3 Minutes of Logging 
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Figure 3 – WEGO Setup 

 

If you are logging engine RPM, you must set the correct value for RPM pulses per revolution (PPR). Some general 
guidelines follow, based on what type of signal you have connected to the WEGO brown wire: 

Tach signal. In most cases PPR= N/2 where N is the number of cylinders. For example, a V-twin motorcycle engine 
would require PPR=1and a V8 automotive engine would require PPR=4 

Harley-Davidson dual fire ignition with connection to Coil- terminal. Use PPR=1 

Harley-Davidson single fire ignition with connection to either Coil- terminal. Use PPR=0.5 

Distributor type ignition with connection to Coil- terminal. Same as for a tach signal. Use PPR= N/2 where N is the 
number of cylinders. 

Wasted spark coil pack (distributorless system) with connection to Coil- terminal. Use PPR=1. 

Coil on plug (no wasted spark) with connection to Coil- terminal. Use PPR=0.5 

Capacitive Discharge (CD) ignition using tach adapter. For one-cylinder engines, use PPR=1 

RPM Debounce – RPM signal filtering in milliseconds (msec). Use the default value of 0.50 msec for most 
applications. Ford 4.6L modular V8 engines will require a value of 3.5 msec. Suzuki Hayabusa models will require a 
value of 3.0 msec. If the RPM trace appears noisy, try a higher RPM debounce value.  

Minimum LED Brightness - This parameter sets the minimum LED brightness under low light (night) conditions. A 
value of 5% is reasonable for most applications. 100% represents maximum brightness. 

After you have entered the correct parameters, click on the Upload to WEGO button. Please note that clicking on 
Restore Defaults only displays default values and does not affect the WEGO unless you then upload the restored values. 
You can check the parameters in a WEGO by clicking on the Download from WEGO button.    

Please note that the WEGO only logs data when the heater elements in the sensors have warmed up to normal 
operating temperature. If you use WEGO software to communicate with the WEGO (i.e. upload parameters, view real-
time data, or download data), data logging stops. The display on the WEGO will also show "PC." You must cycle power to 
the WEGO off and on again before data logging will resume. 

USING DATA LOGGING 

Before using the data logging feature there are several important concepts that need to be understood. 
 

As mentioned previously, the WEGO data buffer stores the last 8000 data points. If you set the data logging 
interval to 0.50 seconds, the unit will log over one hour of data. Data logging intervals of 0.2-1.0 seconds are suitable for 
on-road tests; a shorter interval of 0.10 seconds is recommended for dyno tuning. You can clear the data within the 
WEGO by using the Clear WEGO Data Buffer command from the Communications menu. If you change the data logging 
interval, you should also clear the WEGO data buffer.  To calculate the amount of time available for a configurated 
sampling rate: 

(8000 Samples / Desired Samples per second) / 60 = Minutes of Logging Available 

Example: (8000 / 10) / 60 = 13.3 Minutes of Logging 
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Other important concepts to understand: 

1. Data logging starts immediately after power on and sensors are warmed up.  There is no start/stop function. 
2. Data logging cannot be stopped or paused.  Logging continues until WEGO loses power.  If power is restored 

data logging will automatically restart after the sensors warm up.   
3. Data logged is not lost if power is lost. 
4. The amount of time data logged is directly dependent on the update rate data is saved.  Faster data logging 

means less duration logged.  Again, there are 8000 samples available for data logging. 
5. If the data log buffer is filled the oldest data is replaced to make room for the newest data.  This will continue 

essentially forever. 
6. To prevent any potential loss of data due to using all 8000 samples it is best to use the lowest update rate 

possible and clear the buffer often. 

REAL-TIME DATA DISPLAY 

When the engine is running, you can display WEGO real-time data on an instrument panel type screen by using the 
View Real-time Data command on the View menu. Please note that real-time data cannot be directly saved by means of 
the WEGO program and that the WEGO stops logging data internally during real-time display. 

Real-time data is displayed on an instrument panel type layout with a round tach gauge and bar graph type gauges 
for most other parameters. Diagnostic codes are displayed in an additional window. If the engine is not running, most 
values will appear as zero. 

The difference between the single channel software application and the dual channel software application is 
nothing more than a second channel of live data is displayed.  Figure 4 illustrates this. 

Figure 4 – Single and Dual Channel Real-Time Data Display 

 

Displayed parameters include: 

ANA IN - analog input (always displays actual 0-5V signal level regardless of any analog input scaling) 

TPS%, MAP, or USER - analog input with selected scaling applied. TPS% gauge is always 0-100%. MAP values 
are in In-Hg (29.92 In-Hg corresponds to sea level atmospheric pressure) 

RPM – engine crankshaft RPM (numeric value displayed beneath gauge) 

BAT – battery voltage 

LAMBDA – always displayed regardless of fuel type. 

AFR – only displayed when a fuel type other the Lambda values is selected.  

CEL RES – Displays the Bosch LSU 4.2 internal sensor cell resistance (ohms). Cell resistance drops as the sensor 
warms up. The heater circuitry attempts to maintain the value near 80. Values above 100 after 15-30 second warm 
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up indicate a problem with the sensor heater. Values below 60 indicate sensor overheating due to excessively hot 
exhaust gases and are cause for concern. 

DATA LOGGING CHART DISPLAY 

Data logged by the WEGO unit is displayed on a chart recorder type screen. Data logged by the WEGO unit must 
be downloaded before it can be displayed, by using the Download Data from WEGO command on the Communications 
menu. Once data has been downloaded, it is automatically displayed. The last data logged will appear at the right end 
of the chart.  You can save the data by using the Save File command from the File menu after closing the chart display 
(data is not lost by closing the chart display). You can display a previously saved data file by first using the Open File 
command on the File menu. Note that WEGO data files use a .log extension. You should create a separate folder to store 
these files.  

The difference between the single channel software application and the dual channel software application is 
nothing more than two channels of data logging is displayed.  Please see Figure 5 and Figure 5a. 

You can select two parameters for display. Trace 1 is displayed in red with its Y axis legends on the left side of the 
chart. Trace 2 is displayed in green with its Y axis legends on the right side of the chart. The X axis is always elapsed 
time. You can zoom in, zoom out, or zoom all (displays entire data file). At the maximum zoom in level, approximately 100 
data samples will be displayed on the chart. You can use the scroll bar to move the chart display window in terms of 
elapsed time.  

If you hold the left mouse button down within the chart area, a cursor line appears. The exact values of the 
parameters displayed on trace 1 and trace 2 and the elapsed time appear in windows above the chart. When you zoom in 
or zoom out, the displayed data will always be centered about the cursor line. This allows you to quickly select and closely 
examine an area of interest.  

If you want to analyze the elapsed time between two events, you can move the cursor to the first event and then 
click on the Reset Time Display button. You can print the displayed chart to any Windows printer by clicking on the Print 
button (a color inkjet printer is recommended for best results).  

Data parameters include: 

RPM – engine crankshaft RPM 

AFR – air/fuel ratio or Lambda values (refer to Fuel Type topic on page 7 for details)  

ANALOG INPUT – analog signal input that can be scaled and displayed in user selected units (as explained further 
on). 

You can use the Maximum RPM command from the Edit menu to change the maximum RPM value displayed on 
the chart. 

Additional data is displayed at the lower right side of the screen. This data includes: 

Diagnostic Code – normally blank unless a diagnostic code is set. Diagnostic codes include battery low, battery 
high, sensor open, sensor short, and over temperature. Over temperature means that the WEGO unit (not the 
sensor) has become too hot. 

Stoichiometric Ratio - displayed for selected fuel type (refer to Fuel Type section for details) 

Log Interval – the actual data logging interval in seconds 

The data logging interval is displayed at the lower right side of the screen. The WEGO data buffer stores the last 
8000 samples. You can clear the data within the WEGO by using the Clear WEGO Data Buffer command from the 
Communications menu. If you change the data logging interval, you should also clear the WEGO data buffer. 

Please note that any PC communications, including auto connect when the programs starts, cause the WEGO to 
stop logging data. To restart data logging, disconnect the WEGO from the PC and cycle power to the WEGO off and then 
on again. The WEGO will start logging data when the heater element in the sensor has warmed up to normal operating 
temperature.  
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Figure 5 – Single Channel Data Logging Chart Display 
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Figure 5a – Dual Channel Data Logging Chart Display 
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ANALOG INPUT SCALING 

You can use the Analog Input Scaling command on the Edit menu to setup the scaling and units display for the 
analog input.  

Selections are available for standard Delphi/GM 1 bar, 2 bar, and 3 bar manifold pressure (MAP) sensors. Most GM 
vehicles and all Harley-Davidson® motorcycles with Twin-Cam 88® engines use Delphi 1 bar type MAP sensors. 
Delphi/GM 2 bar and 3 bar MAP sensors are often used with aftermarket engine controls for turbo/supercharger 
applications. 

For other sensors, you will enter the minimum and maximum input voltages and corresponding scaled values 
displayed on the chart along with the desired chart legend. The minimum and maximum voltages must be in the range of 
0.0-5.0 volts. The scaled values must be in the range of 0-10,000.  

Once entered, analog input scaling values are saved with the data. The program also remembers the last analog 
input scaling values. If you use the WEGO for multiple vehicle applications, always verify that the analog input scaling is 
correct for any new data that you download. Clicking on Restore Defaults causes the program to revert to direct 0.0-5.0 
volt display on the chart. 

The figure below shows settings for a typical throttle position sensor (TPS), with 0.4 volts corresponding to 0% and 
4.5 volts corresponding to 100%. 

Figure 6 – Analog Input Scaling 

 
If you are not sure, check the sensor output waveform with a scope meter. Verify that the sensor output is an 

analog voltage within the 0.0-5.0 volt range. Some Ford MAP sensors and GM mass airflow (MAF) sensors use a 
frequency output that is not compatible with the WEGO analog input. Once you verify that the sensor has an analog 
output, you still have to determine the output scaling. You may find this information in the service manual or you may have 
to do some reverse engineering with a scan tool. Additional information is available on the WEGO Tech FAQ at 
www.daytona-sensors.com. 
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Fuel Type 

You can use the Fuel Type command on the Edit menu to select display in Lambda values or to setup the scaling 
of AFR values for most common fuels including a user defined fuel type. After you have made the appropriate selection, 
click on the Upload to WEGO button. 

Figure 7 – Fuel Type Selection 

 

WHEN IT COMES TO USING VARIOUS FUELS PLEASE NOTE: 
1. The WEGO stores data internally as Lambda values. Changing the fuel type only affects display on the WEGO and 

the PC as real-time data or on the chart. 

2. WEGO units with Rev 2.0 or lower firmware do not support the fuel type selection. The display on these WEGO units 
will not change when you upload the new fuel type selection. However, display values on the PC as real-time data or 
on the chart will be updated.  

3. All WEGO units have the decimal point location determined during manufacturing. Special order Lambda units will 
always display numbers in X.XX format. Standard units will always display numbers in XX.X format.     

4. Once entered, the fuel type (and corresponding stoichiometric ratio) is saved with the data. The program also 
remembers the last fuel type. If you use the WEGO for multiple vehicle applications, always verify that the fuel type is 
correct for any new data that you display in real-time or download 

AFR TABLE DISPLAY 

AFR (air/fuel ratio) table (Figure 8) display is only possible when both engine RPM and correctly scaled throttle 
position sensor (TPS) data has been logged from a fuel injected vehicle. TPS data must be correctly scaled from zero to 
100%. Refer to Analog Input Scaling section on page 6. Please note the AFR table display is currently available only for 
gasoline fuel.  

Show in Figures 8 and 9 and single channel WEGOs.  Dual Channels applications allows switching between the 
sensors. 

AFR data that has been logged can be analyzed and displayed by using the View AFR Table command on the 
View menu. The table format is intended to match the RPM rows and TPS columns used by most engine mapping 
systems. The screen snapshot in Figure 8 shows AFR data display. 

  

NOTE:  To gain a better understanding of tuning various fuels please read “What is Air/Fuel 
Ratio?  What is Lambda? Why should I care?” located at the end of these instructions.  
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Under Table Parameters, you can select: 

AFR Display – air/fuel ratio sensor data (as shown above). Any cells that differ at least 0.5 AFR from the target 
AFR value are shaded blue for rich or red for lean.  

Fuel Percent Correction Display – required fuel correction in percent, based on the target AFR value. Any cells 
that differ at least 0.5 AFR from the target AFR value are shaded blue for rich or red for lean. 

Target AFR – target value used to determine required percent fuel correction.   

Minimum Samples Per Cell – default value is 5. Setting a lower higher value results in more accurate table 
values, but may result in fewer total cells with enough samples to appear in the table. If you have limited data (such as a 
single file) try using a lower value. More cells will appear. 

Filter Unstable Data – when this option is selected, a data sample is only included if the preceding sample was 
also in the same cell. This option reduces errors during transients, but may prevent any data from being included during 
rapid acceleration.  

After change the table parameters, you must click on the Refresh Table button to display the revised table.  

Figure 8 – Single Channel AFR Display 

 
 

The screen snapshot in Figure 9 shows fuel percent correction display. You can click on the Print button to print out the 
table.  

You can analyze data from multiple files that you previously saved. If you want to add more data (perhaps logged 
under conditions that will yield coverage of additional cells), use the Open Additional File command from the File menu. 
The data will be analyzed and incorporated into the table. You can open an unlimited number of additional files. However, 
you cannot refresh the table parameters once you open an additional file. These selections will become grayed out. Also, 
you cannot save or view the original data once you open an additional file. Make sure you save any downloaded data 
before opening an additional file.  
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To start a new analysis, you must exit from AFR Table Display and then use the Open File (or Download) 
command from the main menu. 

Figure 9 – Single Channel Fuel Correction Display 

 

TUNING RECOMMENDATIONS 
You can use two approaches to make the required corrections in third party engine mapping systems. If you have 

Microsoft Office with Excel, you can directly copy and paste data from the WEGO Log software to an Excel spreadsheet 
and then copy and paste from the Excel spreadsheet into the engine mapping software. In the WEGO Log software, you 
can select a range of cells with the mouse and right click to bring up a copy menu. You can also left click on the upper left 
legend cell to select the entire table and then right click to bring up the copy menu. For more details on using Excel, 
including sample spreadsheets, please visit the WEGO Tec FAQ on our website at www.daytona-sensors.com. 

Alternately, you can manually enter the required corrections in the engine mapping software by applying the printed 
fuel percent corrections calculated by the WEGO Log software to the fuel table in your engine mapping software. You are 
adding the calculated fuel percent correction values from the WEGO Log software to the fuel table. You can mark off cells 
as you edit them. 

  



 

Daytona Sensors LLC, 240 Springview Commerce Drive - BLD 1 Suite J Debary, FL 32713                 WEGO 
(386) 322-7390   www.daytona-sensors.com                1/2020 

Page 31 

BASIC TUNING STEPS USING THE WEGO 

Step 1. 

Install the WEGO system. Refer to the WEGO installation instructions for tach and TPS signal hookup. Access to a 
shop manual with electrical diagrams for your vehicle is highly recommended. Verify that the TPS signal is correctly 
scaled. Refer to the Analog Input Scaling section on page 6. Verify that the RPM and TPS values are correctly 
displayed in data logging chart display. The legend text must contain TPS% exactly as shown in Figure 6, 
otherwise an error message will appear when you try to use the AFR table display feature. 

Step 2. 

Start with an available file for your engine mapping software that most closely matches your application. Some 
maps will only have a single fuel table. If the map has individual fuel tables for each cylinder, you can place the 
WEGO sensor in the corresponding exhaust pipe and tune each cylinder in turn.  

Step 3. 

Use the WEGO system to log, download, and save several sets of data under varying conditions. Use a medium 
data logging interval (0.5 sec) for runs at steady speeds and a short interval (0.10 sec) for runs with rapid 
acceleration and transients including dyno tests.  

Step 4. 

Data in deceleration areas (low 0-2% TPS above idle RPM) should be regarded with caution as exhaust reversion 
effects may cause errors. Unless you are experiencing a significant problem during decel, we suggest that you 
ignore these cells.  

Step 5. 

Analyze the data, enter the required corrections in the engine mapping software, save your edited map to a file, 
and send the map to the ECM.   

Step 6. 

Repeat steps 3-5 until no shaded cells (excessively rich or lean) appear in the fuel percent correction table. Don’t 
worry about cells with a few percent error or minor imbalance between cylinders.  

Importing Data into MS Excel 

Data files saved from WEGO software are in comma delimited ASCII format. You can easily import a data file into 
other programs such as Microsoft Excel for further analysis. You can also view data files with a text editor such as 
Windows WordPad. To import a data file into Excel: 

1. Start Excel. In the File Open dialog box, select Files of type: All Files (*.*). Then browse for the data file. 

2. The Text Import Wizard appears. For step 1, select delimited file type. For step 2, select comma delimiter. For step 3, 
select general column data format. Then click on Finish. 

3. You can then format the data and save the spreadsheet as an Excel file. 

AFR data is saved as gasoline AFR values (with stoichiometric ratio 14.69) regardless of fuel type setting. To 
convert to other fuel types, use the formula: 

AFR_Fuel = (Stoichiometric_Ratio_Fuel  x AFR)/14.69 

To convert to Lambda units, use the formula: 

Lambda = AFR/14.69 

IMPORTANT NOTE:  To gain a better understanding of tuning various fuels please read 
“Air/Fuel Ratio and Lambda White Paper” located at the end of these instructions.  
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TROUBLESHOOTING FLOWCHART 
Follow the troubleshooting flowchart shown below. Experience has shown that most communication problems are 

user error or PC compatibility issues. 

Troubleshooting Flowchart 
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TUNING VARIOUS FUELS.  WHAT IS LAMBDA? WHY SHOULD I CARE? 
When using a Daytona Sensors WEGO system for tuning it is important to understand the data provided by the WEGO 
system. This white paper is our attempt to clear up some common misconceptions about Lambda.  First it is important to 
understand a few basics about how a “wideband oxygen sensor works. 

From Wikipedia: 

“In an internal combustion engine or industrial furnace, the air-fuel ratio is an important measure for anti-pollution and 
performance-tuning reasons. If exactly enough air is provided to completely burn all of the fuel, the ratio is known as the 
stoichiometric mixture is often abbreviated to “stoich”. 

Most “Wideband” oxygen sensors, including the LSU 4.2 sensor are designed to generate a voltage in reference to stoich.  
This means that the LSU 4.2 operates natively in determining stoich, not in Air/Fuel ratios as widely believed. The sensor 
does this regardless of the type of fuel. 

Lambda is a simple way to indicate a burnt air/fuel mixture referenced to how the sensor operates.  Stoich for any given 
fuel will be represented as the number 1.0 Lambda.  For example, A mixture of 20% richer (less available oxygen) is 
represented as .8 Lambda.  A mixture 20% leaner (more available oxygen) will be represented as 1.2 Lambda. 

Using Lambda makes tuning various fuels almost a “no brainer”.  Most automotive internal combustion engines operate 
best at or near stoich at idle and lighter loads.  But for maximum power and heat protection a mixture 20-25% richer are 
desired.  This is easy to do if you are using Lambda when tuning. 

If a tuner decides to use Air/Fuel Ratio over Lambda to tune things change a bit.  There are two ways this can be 
addressed. 

1. Convert the Lambda indication into Air/Fuel Ratio using the published “stoichiometric ratio” for the fuel being 
used.  If that is actually accurate, many times, this value is not exactly correct or floats a bit.  This will display a 
“properly” referenced Air/Fuel ratio indication.  However, if the actual stoich of your fuel varies…this will introduce 
inaccuracies. 

2. Do nothing.  If the stoich value in your Wideband is defaulted to a gasoline stoich value (14.64:1) tune your 
vehicle the way you would normally tune it.  Realized that your Fuel/Air mixture is a math conversion of Lambda, 
14.64:1 is still 1.0 Lambda.  20% richer is still 20% richer and 20% leaner is still 20% leaner.  What is important at 
that point is the percentage of the change richer or leaner.  Not the actual number. 

Another consideration when choosing a wideband is the ability of the unit to alter the wideband to display the wide range 
of readings required to display Fuel/Air ratios.  Daytona Sensors WEGOs are available in both forms: Lambda (0.70 – 
1.33) and Gasoline Fuel/Air ratios (10.3:1 to 19.5:1). 

Remember, that Fuel/Air is only a math conversion from Lambda using the published stoich value for that fuel that was 
used for the conversion (typically 1.0 Lambda = 14.64 stoich Gasoline). 

In our opinion, due to potential conversion error - it’s simply better to tune a vehicle using a Lambda target value.  

EXAMPLES – METHANOL AND E85 FUEL 

METHANOL FUEL: 

The stoich (Lambda 1.0) for methanol is normally about a 4:1 Air/Fuel Ratio.  

Using a Lambda Display Wideband: If you want to run a methanol engine for maximum power near 3:1 Fuel/Air Ratio or 
richer, you would run the vehicle at WOT and adjust the fuel while monitoring with your Daytona Sensors wideband until it 
displayed a Lambda of 0.75 Lambda.   

Using a Gasoline Fuel/Air Display wideband kit (10.3-19.5 AFR) with methanol fuel. In order to achieve a 3:1 Fuel/Air 
Ratio you would adjust the fuel until our wideband displays 10.98 (14.64*0.75).  In this case with methanol fuel, the 
conversion factor from Lambda to Fuel/Air for DISPLAY on the wideband is wrong.  However, the base Lambda value that 
is converted to the gasoline value is still correct. 
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E85 Fuel: 

The stoich (Lambda 1.0) for E85 is normally about a 9.765:1 Air/Fuel Ratio.  

Using a Lambda Display Wideband: If you want to run a E85 engine for maximum power at big boost near 7.32:1 Fuel/Air 
Ratio or richer, you would run the vehicle at WOT and adjust the fuel while monitoring with your Daytona Sensors 
wideband until it displayed a Lambda of 0.75 Lambda.   

Using a Gasoline Fuel/Air Display wideband kit (10.3-19.5 AFR) withE85 fuel. In order to achieve a 7.32:1 Fuel/Air Ratio 
you would adjust the fuel until our wideband displays 10.98 (14.64*0.75).  In this case with E85 fuel, the conversion factor 
from Lambda to Fuel/Air for DISPLAY on the wideband is wrong.  However, the base Lambda value that is converted to 
the gas 
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WEGO DYNAMOMETER INSTALLATIONS 

REQUIRED PARTS (ALL DYNO INSTALLATIONS) 

For use on a Dyno all WEGO units will require a 13.8V regulated power supply capable of supplying a minimum 6 
amp current. Appropriate power supplies include P/N 136581 available from Jameco (www.jameco.com) or P/N 72-8142 
from MCM Electronics (www.mcmelectronics.com).   

The power supply must be located in close proximity to the WEGO unit. We recommend mounting the WEGO unit 
on a panel next to the dyno data acquisition system and then running extension cables out to the sensors in the dyno 
room. Keep all power and ground connections as short as possible. Follow the exact layout shown in Figure 4. Do 
not add additional terminal blocks or connectors to power or ground connections. 

DYNO GROUNDING (ALL DYNO INSTALLATIONS) 

Improper grounding will cause serious problems. The dyno frame or chassis must be connected to building 
electrical ground in accordance with National Electrical Code (NEC) requirements.  Vehicles operated on a chassis dyno 
will generate considerable electrostatic charge. The vehicle must be grounded to the dyno frame while in operation. You 
can use a length of 16 AWG wire with one end secured to the dyno frame and the other end equipped with a heavy-duty 
alligator clip that is attached to the vehicle frame or other vehicle ground point. Failure to ground the vehicle will lead to 
electrostatic discharge (ESD) across the WEGO sensor damaging the sensor and WEGO unit. 

DYNOJET 

DYNOJET OVERVIEW 

The WEGO can be interfaced to a Dynojet® dyno by means of the Dynojet® analog module.  Correctly scaled 
air/fuel ratio data for two channels can then be displayed and charted along with other dyno data in the Dynojet® WinPEP® 
software.  You will require two unterminated sensor cables available from Dynojet® 

For more information about the Dynojet® analog module and WinPEP® software, please refer to the Dynojet® 
website at www.dynojet.com.  

Once installed, the WEGO can be used with easily fabricated exhaust sniffers for automotive and motorcycle 
applications described in tech notes available on our Tech FAQ at www.daytona-sensors.com 

DYNOJET DYNO HOOKUP 

Refer to Figure 1. You can use this same hookup for any WEGO series unit (for single channel units, only one 
channel is connected). One Dynojet® sensor cable is required for each channel. The red wire for +5V power on the sensor 
cable is not used and must be taped up. The grounding strap on the back of the analog module (refer to Figure 1-4 in the 
Dynojet® analog module documentation) can be used for the common dyno ground point shown in Figure 10 and Figure 
11.  

DYNOJET CONFIGURATION 

Refer to the Dynojet® analog module documentation for details. Select an appropriate display name for each 
channel, such as Front AFR. Voltage levels are 0V at 10 AFR and 5.0V at 20 AFR.  For proper scaling the SLOPE 
setting should be 2 and the OFFSET should be 10. 

CAUTION: To avoid damage to the WEGO, a secure ground connection must be established 
between the vehicle and dyno chassis before connecting tach or analog signals from the 
vehicle. 

INFO: If your dyno is not covered in this manual please contact Daytona-Sensor customer 
support.  Phone: 386-322-7390 (9AM-4PM EST) 
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Figure 10 – Typical WEGO Hookup to Dynojet® Analog Module 

 
Figure 11 – Typical Dyno Hookup for WEGO IV Dual Display 

 

DYNOJET®  

ANALOG 

MODULE 
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DYNOMITE 

DYNOMITE DYNO OVERVIEW 

WEGO systems can be interfaced to a Land & Sea DYNOmite dyno by means of the DYNOmite data acquisition 
module. Correctly scaled air/fuel ratio data for two channels can then be displayed and charted along with other dyno data 
in the Land & Sea, DYNO-MAX Pro software. The kit includes a WEGO dual channel wide-band exhaust gas oxygen 
sensor interface, two Bosch LSU 4.2 wide-band sensors, two custom length sensor extension cables, and power supply.  

ADDITIONAL REQUIRED PARTS AND CABLE ROUTING (ALL DYNO INSTALLATIONS) 

The dyno system must be equipped with the DYNOmite Pro data acquisition module. You will require two of the 
seven available 0-5 volt channels.  The WEGO unit can be mounted on the dyno console using screw hardware or Velcro 
material (not supplied). Choose a mounting location that will allow access to the calibration trimpots and status LEDs. The 
power supply should be located on the floor in a dry area. The WEGO has three-foot sensor cables. Before ordering, 
carefully measure the required length of the sensor extension cables, allowing several feet slack. Route the sensor 
extension cables away from sources of AC electrical noise and exhaust heat. 

DYNOMITE DYNO HOOKUP 

Refer to Figure 12. Connect the sensor extension cables and Bosch sensors. Channel 1 is color coded with a 
yellow band. Connect the WEGO to the power supply. Connect the power supply to 120 VAC power. Note that the power 
supply has a universal 100-240 VAC input. For overseas use, you will have to supply an appropriate power cord. The 
power supply should be connected to a switched AC outlet. To avoid sensor damage from exhaust deposits, power must 
be turned on whenever the sensors are exposed to exhaust gases.  

You can use this same hookup for any WEGO series unit (for single channel units, only one channel is connected). 
One 0-5 volt channel is required for each sensor. Each connection to the DYNOmite harness will only require the signal 
and ground wires. You will not use the orange (5 volt) or red/white (8 volt) wire for the connection. The ground wire from 
the DYNOmite harness should be connected to the same common ground point used for the external power supply. Refer 
to the DYNOmite documentation for channel color codes.  

Figure 12 – WEGO Hookup to DYNOmite Module 
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DYNOMITE SYSTEM CONFIGURATION  
Voltage levels are 0 volt at 10 AFR and 5.0 volt at 20 AFR.  

For calibration in DYNO-MAX software, first make sure that you have a new run open and that the DYNOmite data 
acquisition module is communicating with the DYNO-MAX software. Next, access the Electronics – Calibrate DYNOmite 
Channels menu. From this menu you can custom calibrate the two 0-5 volt channels that are connected to the WEGO IID 
system.  

Figure 13 shows entries for sensor 2 calibration. Sensor 2 is connected to the 0-5 Volt 1 channel. The other sensor 
is connected to the 0-5 Volt 2 channel. For calibration you need to enter the 10 @ 0 and 20 @ 5 entries then select the 
Calibrate to entered values button. You can optionally change the corresponding tab’s name by entering in AFR 2 in the 
field next to where it says 0-5 Volt 1 and then selecting the Apply button (located at the bottom of the menu). You can also 
optionally select the appropriate unit system from the drop-down menus.  

Figure 13 – DYNO-MAX Configuration 

 

SUPERFLOW 

SUPERFLOW SYSTEM OVERVIEW 

This WEGO kit is intended for easy hookup to a Dynamic Test Systems (DTS) dyno that was previously equipped 
with ECM AFM1000 wide-band exhaust gas oxygen sensor interfaces. The kit includes a WEGO dual channel wide-band 
exhaust gas oxygen sensor interface, two Bosch LSU 4.2 wide-band sensors, two custom length sensor extension cables, 
and power supply. The WEGO is supplied with connectors that directly plug into the DTS data acquisition box. 

SUPERFLOW DYNO HOOKUP 

Refer to Figure 14. Connect the sensor extension cables and Bosch sensors. Channel 1 is color coded with a 
yellow band. Connect the WEGO to the power supply. Connect the power supply to 120 VAC power. Note that the power 
supply has a universal 100-240 VAC input. For overseas use, you will have to supply an appropriate power cord. The 
power supply should be connected to a switched AC outlet. To avoid sensor damage from exhaust deposits, power must 
be turned on whenever the sensors are exposed to exhaust gases.  

Connect the WEGO output to the DTS data acquisition “red box” on channel 15 and 16. Mating connectors are 
installed on the WEGO IIID, with channel 15 identified by a yellow band at the connector end.  
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SUPERFLOW SYSTEM CONFIGURATION  

The WEGO output is scaled differently than the ECM AFM1000, thus the dyno configuration file must be edited.  

1. In the main run screen, exit to DOS by pressing CTLR and E.  This will bring you to ‘C:\DTS>’ 

2. Type in calchan and press ENTER. 

3. PAGE UP to channel 15.  Scroll (using arrow key) down to ‘Read Lo’: type in 11.0 and press ENTER. Scroll to 
‘Read Hi’: type in 20.0 and press ENTER. 

4. After pressing ENTER to save, press ESC to return to the DOS prompt. 

5. At DOS prompt, type DTS4000G and press ENTER. 

6. You will now be back at the main run screen.  When the units are on, you should see ’20.0’ on the screen on 
both channel 15 and 16. 

Figure 14 – WEGO Hookup to Dynamic Test Systems (DTS) SuperFlow Dyno 
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